Measurement Guide

Signal Generators for Anritsu RF and Microwave Handheld Instruments

BTS Master™
Spectrum Master™

Tracking Generator Option 20
Vector signal Generator Option 23
Table of Contents

Chapter 1—General Information
1-1 Introduction ................................................. 1-1
   Selecting Tracking Generator Option ....................... 1-1
   Selecting Vector Signal Generator Mode ................... 1-1
1-2 Contacting Anritsu ...................................... 1-1
1-3 Product Information, Compliance, and Safety .......... 1-1

Chapter 2—Tracking Generator (Option 20)
2-1 Introduction .............................................. 2-1
2-2 Tracking Generator Operation ............................ 2-1
2-3 Measurement Example ..................................... 2-1
2-4 Tracking Generator Menus ................................. 2-6
2-5 Measure Menu ............................................. 2-7
2-6 Measure 2/2 Menu ......................................... 2-8
2-7 Tracking Generator Menu ................................ 2-9
2-8 $S_{21}$ Insertion Loss Menu ............................... 2-10

Chapter 3—Vector Signal Generator (Option 23)
3-1 Introduction .............................................. 3-1
3-2 Signal Generator Features ................................. 3-1
3-3 Vector Signal Generator Setup ........................... 3-1
3-4 Frequency Parameters .................................... 3-2
   Signal Parameters ......................................... 3-2
   Interferer Parameters .................................... 3-3
3-5 Amplitude Parameters .................................... 3-4
   Set the Signal, Interferer, and Noise Output Modes ...... 3-5
3-6 Setup Menu Parameters ................................... 3-6
   VSG Custom Pattern Management ......................... 3-6
3-7 Generator Modulation Pattern ............................ 3-8
   Signal Pattern and Interferer Pattern .................... 3-8
   Spectrum Inversion (Normal Reverse) ..................... 3-11
3-8 Turning on the Signal Generator ......................... 3-12
3-9 Vector Signal Generator Menus .......................... 3-13
3-10 Freq (Frequency) Menu .................................. 3-14
3-11 Amplitude Menu ......................................... 3-15
Table of Contents (Continued)

3-12 Setup Menu ................................................................. 3-16
   Pattern Manager Menu .................................................. 3-16
   Add Pattern Menu ....................................................... 3-17
   Delete Pattern Menu ................................................... 3-17

3-13 Modulation Menu ...................................................... 3-18
   Edit Signal Menu ......................................................... 3-18
   Edit Interferer Menu ................................................... 3-19

3-14 RF On/Off ................................................................. 3-23

Index
Chapter 1 — General Information

1-1 Introduction

This Measurement Guide documents the Tracking Generator (Option 0020) and the Vector Signal Generator (Option 0023). Check the user guide for your Anritsu handheld instrument to find which options are available. An available option must be installed in your instrument before it can be used.

Selecting Tracking Generator Option

If the Tracking Generator option is installed in your instrument, then in the Spectrum Analyzer mode, a Tracking Generator submenu key is available in the Measure 2/2 menu. Refer to Figure 2-6, “Measure Menu with Tracking Generator (Option 20)” on page 2-6.

1. Press the Shift key followed by pressing the Measure (4) key on the numeric keypad to open the Measure menu.
2. Press the More submenu key to open the Measure 2/2 menu.
3. Press the Tracking Generator submenu key to open the Tracking Generator menu.

Selecting Vector Signal Generator Mode

1. Press the Shift key followed by pressing the Mode (9) key on the numeric keypad to open the Mode Selector list box.
2. Use the directional arrow keys or the rotary knob to highlight the Vector Signal Generator mode, then press the Enter key to select.

| Caution | The maximum input power without damage is +30 dBm on the RF In port. To prevent damage, always use a coupler or high power attenuator. |

1-2 Contacting Anritsu

To contact Anritsu, visit the following URL and select the services in your region: http://www.anritsu.com/contact-us.

1-3 Product Information, Compliance, and Safety

Read the Handheld Instruments Product Information, Compliance, and Safety Guide (PN: 10100-00065) for important safety, legal, and regulatory notices before operating the equipment. For additional information and literature covering your product, visit the product page of your instrument and select the Library tab.
Chapter 2 — Tracking Generator (Option 20)

2-1 Introduction

The Tracking Generator operates over a frequency range of 100 kHz to 7.1 GHz, and provides a signal with an output frequency that is the same as the tuning frequency of the MS2721B spectrum analyzer. The output power and level accuracy are specified from 450 kHz to 7.1 GHz. When the spectrum analyzer is set to zero span, the output is a CW signal. The output power is leveled and can be adjusted from 0 dBm to –40 dBm in 0.1 dB steps.

2-2 Tracking Generator Operation

1. Press the Track Gen Off/On submenu key to turn On and Off the output of the tracking generator. The output power turns on at the level that has been set previously with the Output Power submenu key.
2. Press the Output Power submenu key and set the output power (at the output connector) from 0 dBm to –40 dBm, in 0.1 dB steps. The output is leveled and flat over the specified frequency range of the tracking generator.
3. If you change a setting and want to restart the sweep, press the Reset Sweep submenu key. The sweep restarts at the lowest frequency that is selected and also restarts Averaging.

2-3 Measurement Example

This example demonstrates how to calibrate the instrument and make a measurement.

1. Set the frequency range to cover the range of the DUT being tested. In this example, the center frequency is set to 1.96 GHz with a 500 MHz span.
2. The Tracking Generator can become slow if sweep detection is set to any method other than Sample. To set the detection method to Sample, press the Shift key, then the Sweep (3) key. Then press the Detection submenu key and press Sample for the fastest sweeps.
3. Press the Shift key, then the Measure (4) key.
4. Press the More submenu key to open the Measure 2/2 menu.
5. Press the Tracking Generator submenu key.
6. Press the Track Gen Off/On submenu key to turn on the output of the tracking generator (the current state, On or Off, is underlined on the submenu key display).
7. Press the Output Power submenu key and set the output power for the device that is being measured, from 0 dBm to –40 dBm, in 0.1 dB steps. In this example, which is measuring a band pass filter, the power level is set to 0 dBm in order to get the maximum signal through the filter. (The band pass filter that was used in this example...
is similar to the 1850 MHz to 1910 MHz, 50 ohm band pass filter, Anritsu part number 1030-111-R).

8. Connect the DUT between the RF Out and RF In connectors on the instrument. Use good quality cables and adapters to make the connections.

9. Observe the measurement to confirm that the frequency range covers the frequency range that was intended.

10. If the spectrum analyzer noise floor is too high for the necessary measurements, then reduce the input attenuation and RBW to maximize the dynamic range. Probably, the scale will need to be changed from 10 dB/division to a higher value to see the stop band of a good filter. In this example, the scale is changed to 15 dB/division in Step 17 (as shown in Figure 2-5 on page 2-5).

11. When measuring a filter with a very high insertion loss in the stop band, press the Shift key, then the Trace (5) key. Press the Trace A Operations submenu key, then the Average → A submenu key to turn on averaging and clean up the stop band area. An averaging value of 10 will probably be adequate for most filters.
12. After the frequency range and other settings are satisfactory, disconnect the DUT and make a THROUGH connection between the RF Out and RF In connectors. For the most accurate results, use the same cables and adapters for this connection as were used to connect the DUT.

13. Confirm that the display shows a nearly flat signal when the THROUGH is connected. If the signal is not reasonably flat, then verify that the cables and connections are in good condition and that the connectors are properly tightened.

14. Press the S21 Insertion Loss submenu key.

15. Press the Normalize submenu key to set Normalization On (the current state, On or Off, is underlined on the submenu key display).
Figure 2-3 shows the THROUGH measurement after normalization. Note the relative scale numbers on the graticule lines (in increments of 10 dB) on the right side of the sweep window now that Normalization is **ON**. If desired, the resolution bandwidth and video bandwidth can be changed after normalization without needing to renormalize. If the input attenuation is changed, then a new normalization sweep is required. After the normalization sweep is finished, reconnect the DUT between the RF Out and RF In connectors. Figure 2-4 shows the filter measurement after normalization.

**Figure 2-3.** Flat Sweep After Normalization (Relative Scale at 10 dB/division)
17. If necessary, press the Relative Scale submenu key and change the scale to view the entire measurement.

Figure 2-4. Measurement After Normalization (Relative Scale at 10 dB/division)

Figure 2-5. S21 Scale Changed to 15 dB/division
2-4 Tracking Generator Menus

The tracking generator frequency is controlled with the spectrum analyzer Frequency and Span menus. Other tracking generator controls are in the Measure menus. To access the functions under the Measure menu, press the **Shift** key, then the **Measure** (4) key. The addition of Option 20 adds the Tracking Generator submenu key and subsequent menus, as shown Figure 2-6.

![Figure 2-6. Measure Menu with Tracking Generator (Option 20)]
# 2-5 Measure Menu

**Key Sequence:** Measure (Shift + 4)

<table>
<thead>
<tr>
<th>Measure</th>
<th>Field Strength: Press to activate the Field Strength measurement function.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>OCC BW: Press to open the Occupied Bandwidth menu.</td>
</tr>
<tr>
<td></td>
<td>Channel Power: Press to activate the Channel Power measurement function.</td>
</tr>
<tr>
<td></td>
<td>ACPR: Press to open the Adjacent Channel Power Ratio menu.</td>
</tr>
<tr>
<td></td>
<td>AM/FM Demod: Press to open the AM/FM Demodulation menu.</td>
</tr>
<tr>
<td></td>
<td>C/I: Press to activate the Carrier to Interference measurement function.</td>
</tr>
<tr>
<td></td>
<td>Measurement Off: Press to turn Off any active measurement, including demodulation.</td>
</tr>
<tr>
<td></td>
<td>More: Press to open the Measure 2/2 menu.</td>
</tr>
</tbody>
</table>

![Measure Menu Diagram](image)

**Figure 2-7.** Measure Menu
2-6 Measure 2/2 Menu

Key Sequence: **Measure (Shift + 4) > More**

**Tracking Generator:** Press to turn the tracking generator On and Off. The output power is turned on at the level that was previously set with the Output Power submenu key.

**Emission Mask:** Press to open the Emission Mask menu. For a description of this menu, refer to the Spectrum Analyzer Measurement Guide (Anritsu part number 10580-00231).

**Measurement Off:** Press to turn off the current measurement.

**Back:** Press to return to the Measure menu.

*Figure 2-8. Measure 2/2 Menu*
2-7 Tracking Generator Menu

Key Sequence: Measure (Shift + 4) > More > Tracking Generator

Track Gen
Off  On: Press to turn Off and On the output of the tracking generator. The output turns On at the level that has been set with the Output Power submenu key. The current state (Off or On) is underlined.

Output Power: Press to set the output power from 0 dBm to –40 dBm.

Reset Sweep: Press to restart the measurement sweep at the lowest set frequency.

S21 Insertion Loss: Press to open the S21 Insertion Loss menu and to manage relative measurements.

Abs Max, Min, Avg
Off  On: Press to toggle this function Off and On. This feature shows the power (in dBm) of the lowest and highest points along with the numeric average of all data points. The current state (Off or On) is underlined.

Back: Press to return to the Measure menu.

Figure 2-9. Tracking Generator Menu
2-8  S₂¹ Insertion Loss Menu

Key Sequence: Measure (Shift + 4) > More > Tracking Generator > S₂¹ Insertion Loss

<table>
<thead>
<tr>
<th>S₂¹ Insertion Loss</th>
<th>Normalize</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Off  On</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Normalize

Off  On: Press to toggle Normalization Off and On. When turned On, a calibration process is started. Make a THROUGH connection between the tracking Generator Output and the Spectrum Analyzer Input connectors before performing normalization. For the most accurate results, use the same cables and adapters that will be used for the normalization measurement. The current state (Off or On) is underlined.

Relative Ref: Press to set the value of the top graticule line in dB relative to the THROUGH connection that was made when normalization was performed.

Relative Scale: Press to set the scale factor from 1 dB/division to 15 dB/division in 1 dB steps.

S₂¹ Max, Min, Avg

Off  On: Press to toggle Off and On a measurement box that shows the maximum signal, the minimum signal, and the numeric average of all data points in dB. The current state (Off or On) is underlined.

S₂¹ RL Offset: Press to compensate for amplifiers or attenuators that have been added to the measurement path after normalization. Use negative values for added attenuation and positive values for added amplification.

Back (S₂¹ OFF): Press to return to the Tracking Generator menu and to turn Off S₂¹ normalization and the relative measurement function.

Figure 2-10. Setup Menu
Chapter 3 — Vector Signal Generator (Option 23)

3-1 Introduction

The BTS Master with Option 23 offers a Vector Signal Generator (VSG) with the capability of generating a single waveform or two different waveforms within a 10 MHz bandwidth. Each waveform can be a CW signal, or can have analog, digital, and custom modulation.

3-2 Signal Generator Features

- 400 MHz to 6 GHz
- –124 dBm to 0 dBm, CW Single Channel
- –124 dBm to –8 dBm, modulated, noise, or multicarrier (multichannel)
- One signal to 10 MHz bandwidth, or two signals to 5 MHz bandwidth each, plus Additive White Gaussian Noise (AWGN)
- Wideband AWGN Noise Source (approximately 15 MHz bandwidth)

The level control range for any active channel is –124 dBm to 0 dBm, within the limitations of the total power specification. The VSG produces a minimum power level of –124 dBm per channel, where each signal is considered to be a channel (for example, signal 1, signal 2, and noise). The maximum power specification is 0 dBm for a single CW signal, –8 dBm for a single modulated signal, and –8 dBm total for multi-channel operation. Note that noise channel power is included when considering the total power.

3-3 Vector Signal Generator Setup

The following procedures configure the signal, interferer, and noise patterns for signal generation.
3-4 Frequency Parameters

Press the Freq main menu key to display the Freq menu.

Signal Parameters

Manually Enter the Signal Frequency:

1. Press the Signal Frequency submenu key. The frequency on the submenu key turns red for editing.

2. Enter the desired signal frequency using the keypad, the arrow keys, or the rotary knob. When entering a frequency using the keypad, the submenu key labels change to GHz, MHz, kHz, and Hz. Press the appropriate unit key to terminate the entry.

3. To complete data edit or entry, press Enter or ESC to cancel.

Select a Communications Systems Standard:


2. Highlight the desired signal standard.

3. Press Enter to set the new signal standard.
Set the Signal Channel Number:
1. Press the Sig Channel Num submenu key. The Channel Editor dialog box opens.
2. Enter or scroll to the desired channel.
3. Press Enter to set the new channel.

Set the Signal Frequency Step:
1. Press the Sig Freq Step submenu key.
2. Enter the desired signal frequency step using the keypad, the arrow keys, or the rotary knob.
3. To complete the data edit or entry, press Enter or press ESC to cancel.

Interferer Parameters
Manually Enter Interferer Frequency Offset:
1. Press the Interferer Freq Offset submenu key.
2. Enter the desired interferer frequency offset by using the keypad, the arrow keys, or the rotary knob.
3. To complete data edit or entry, press Enter or ESC to cancel.

Set the Interferer Frequency Step:
1. Press the Int Freq Step submenu key.
2. Enter the desired signal frequency step using the keypad, the arrow keys, or the rotary knob.
3. To complete the data edit or entry, press Enter or ESC to cancel.
3-5 Amplitude Parameters

Press the **Amplitude** main menu key to display the Amplitude menu.

| Note | All RF output is disabled unless the RF ON/OFF main menu key is toggled to RF Output: ON. Refer to “RF On/Off” on page 3-23. |

**Set Signal Level:**
1. Press the **Signal Level** submenu key. The signal level value on the submenu key turns red for editing.
2. Enter the desired signal amplitude using the keypad, the arrow keys, or the rotary knob.
3. To complete data edit or entry, press **Enter** or **ESC** to cancel.

**Set Interferer Level:**
1. Press the **Interferer Level** submenu key. The interferer level value on the submenu key turns red for editing.
2. Enter the desired interferer level using the keypad, the arrow keys, or the rotary knob.
3. Press **Enter** to complete the entry or **ESC** to cancel.

**Set Noise Level:**
1. Press the **Noise Level** submenu key. The noise level value on the submenu key turns red for editing.
2. Enter the desired noise level using the keypad, the arrow keys, or the rotary knob.
3. Press **Enter** to complete the entry or **ESC** to cancel.

**Set Level Offset:**
1. Press the **Level Offset** submenu key. The level offset value on the submenu key turns red for editing.
2. Enter the desired level offset using the keypad, the arrow keys, or the rotary knob.
3. Press **Enter** to complete the entry or **ESC** to cancel.
Set the Signal, Interferer, and Noise Output Modes

1. Press the Signal submenu key to select CW, Mod (modulation), or Off. When Signal is set to Off, the display indicator and data window text are colored gray. When Signal is set to CW or Mod, the display indicator and data window text are colored yellow. The CW indicator is arrow shaped, while the Mod indicator is rectangle shaped.

2. Press the Interferer submenu key to select CW, Mod (modulation), or Off. When interferer is set to Off, the display indicator and data window text are colored gray. When interferer is set to CW or Mod, the display indicator and data window text are colored green. The CW indicator is arrow shaped, while the Mod indicator is rectangle shaped.

3. Press the Noise submenu key to toggle Noise On or Off. When Noise is set to Off, no indicator is displayed, but data window text is colored gray. When noise is set to On, a white line is drawn horizontally across the graphic display window, and data window text is colored white.

Figure 3-1. VSG Levels Display (example only, your instrument may differ)
### 3-6 Setup Menu Parameters

Press the **Setup** main menu key to list the Setup menu.

**Set Trigger Type:**
- Press the **Trigger Type** submenu key. Scroll to the Pos or Neg edge trigger. If no trigger is required, then select None. The active trigger is underlined.

**Set Trigger Delay:**
1. Press the **Trigger Delay** submenu key. The current value turns red for editing.
2. Enter the desired trigger delay by using the keypad or rotary knob.
3. Press **Enter** to set the new trigger delay.

**To Trigger Manually:**
Press the **Manual Trigger** submenu key to activate the trigger manually. Use this if you are using an external trigger, but for some reason that signal is not working correctly.

### VSG Custom Pattern Management

To use the Custom signals in the Signal Pattern and Interferer Modulation setup, you need to transfer these signals from the instruments internal memory or USB memory device into the VSG Custom Signal Pattern memory. Note that the VSG Custom Signal Pattern memory is non-volatile, so you need to do this only once.

**To Add a Pattern:**
1. Press the **Shift** key followed by the **File** (7) key. The File menu is listed.
2. Press the **Directory Management** submenu key. The Directory Management menu is listed.
3. Press the **Current Location** submenu key to select the current location of the pattern files, Int (internal) or USB (USB memory device). The underlined location is active.
4. Press the **Setup** main menu key. The Setup menu is listed.
5. Press the **Pattern Manager** submenu key. The Custom Signal Pattern folder opens, and the Pattern Manager menu is listed (**Figure 3-2 on page 3-7**).
6. Press the **Add** submenu. The selected folder content (as selected in Step 3, Int or USB) is listed.
7. Highlight the desired signal pattern file and press the **Add Selected Pattern** submenu key. The signal pattern file is added into the Custom Signal Pattern folder. The signal pattern name is displayed in a box at the bottom of the Custom Signal Pattern folder.
8. Repeat Step 6 and Step 7 to continue adding signal patterns into the Custom Signal Pattern folder.
To Delete a Pattern:

1. Press the Setup main menu key. The Setup menu is listed.
2. Press the Pattern Manager submenu key. The Pattern File List dialog box opens and the Pattern Manager menu is listed.
3. Press the Delete submenu key.
4. To delete a single file, highlight the desired pattern and then press Delete Selected Pattern. To delete all pattern files, press Delete All Patterns.
3-7 Generator Modulation Pattern

Modulation patterns are available for both the signal patterns and the interferer patterns. These patterns are presented in a dialog box, which is shown in Figure 3-5, “Custom Modulation Configuration” on page 3-11.

To open the “Custom Modulation Configuration” dialog box, press the Modulation main menu key, then press either the Signal Pattern submenu key or the Interferer Pattern submenu key, then press the Custom submenu key. Refer to Figure 3-14 on page 3-18, Figure 3-15, and Figure 3-16.

To select a custom pattern to use as signal or interferer, press the Custom submenu key to open the dialog box “Custom Modulation Configuration” on page 3-11, which also opens the Modulation Config menu (shown in Figure 3-7, “Main Menu Keys” on page 3-13). A Custom submenu key is available in two menus: Figure 3-15, “Edit Signal Menu” on page 3-18 and Figure 3-16, “Edit Interferer Menu” on page 3-19.

Signal Pattern and Interferer Pattern

Set up the signal and interferer patterns to one of three types of modulation: analog, digital, or custom.

In the following 3 procedures, the signal pattern or interferer pattern is chosen.

Analog Modulation Pattern Setup

In the following procedure, you are directed to choose a Modulation Type, a Rate, and a Deviation for a signal pattern, or you are directed to choose a Modulation Type, a Frequency, and a Depth for an interferer pattern. When selected, these parameters are displayed in the lower section of the sweep window. Refer to “Signal Data” and “Interferer Data” in Figure 3-1 on page 3-5.

1. From the Modulation menu, and after pressing either the Signal Pattern or the Interferer Pattern submenu key, press the Analog submenu key. The Analog Modulation Configuration dialog box opens with the Modulation Type list box highlighted in red. The following figure is an example only. Your instrument may show a different list.

![Figure 3-3. Analog Modulation Configuration (Signal Pattern)
2. Press the **Enter** key or press the **Select** submenu key to list the modulation waveform types.

3. Highlight the desired modulation type by using the **Up/Down** arrow keys or the rotary knob, and then press **Enter**.
   a. (Signal or Interferer) If the Modulation Type is “Sine Wave AM”, then the subsequent choices are “Frequency” and “Depth”.
   b. (Signal or Interferer) If the Modulation Type is “Sine Wave FM”, then the subsequent choices are “Rate” and “Deviation”.
   c. (Signal only) If the Modulation Type is “Pulsed CW”, then the subsequent choices are “Duty Cycle” and “Period”.

4. Use the **Up/Down** arrow keys or rotary knob to highlight the desired Frequency, Rate, or Duty Cycle list box and then press the **Select** submenu key, or press **Enter**.

5. Highlight the desired value (using either the **Up/Down** arrow keys or the rotary knob) and press **Enter**.

6. Use the **Up/Down** arrow keys or rotary knob to highlight the Depth, Deviation, or Period list box and then press **Enter**.

7. Highlight the desired value (using either the **Up/Down** arrow keys or the rotary knob) and press **Enter**.

8. Use the **Up/Down** arrow keys or rotary knob to highlight the **Accept** button (or the **Cancel** button) and then press **Enter**, or press the **Accept** submenu key (or **Cancel** submenu key).

---

**Note**

In Step 4 or Step 7, you may press the Accept submenu key to immediately accept all of the displayed values and return to the previous menu. Or you may press the **Enter** key and go to the next step.
Digital Modulation Pattern Setup

In the following procedure, you are directed to choose a Modulation Type and a signal pattern or an interferer pattern. When selected, each pattern identification is displayed in the lower section of the sweep window. Refer to “Signal Data” and “Interferer Data” in Figure 3-1 on page 3-5.

1. Press the Digital submenu key. The Digital Modulation Configuration dialog box opens with the Modulation Type list box highlighted in red. The following figure is an example only. Your instrument may show a different list.

![Digital Modulation Configuration](image)

**Figure 3-4.** Digital Modulation Configuration

2. Press the **Enter** button or press the **Select** submenu key to select one of the modulation waveform types.

3. Highlight the desired modulation type by using the **Up/Down** arrow keys or the rotary knob, and then press **Enter** or press the **Select** submenu key. The pattern list box is updated to show the available patterns for the chosen modulation type, and one pattern is highlighted.

4. Use the **Up/Down** arrow keys or rotary knob to highlight the pattern list box and press the **Select** submenu key.

5. Use the **Up/Down** arrow keys or rotary knob to highlight the desired pattern and press **Enter**.

6. After selecting the pattern type, use either the **Up/Down** arrow keys or the rotary knob to highlight the **Accept** button (or the **Cancel** button) and then press **Enter**, or press the **Accept** submenu key (or the **Cancel** submenu key).

**Note**  In Step 3 or Step 5, you may press the **Accept** submenu key to immediately accept all of the displayed values and return to the previous menu. Or you may press the **Enter** key and go to the next step.
Custom Modulation Pattern Setup

In the following procedure, you are directed to select a custom modulation pattern. When selected, the pattern identification is displayed in the lower section of the sweep window. Refer to “Signal Data” and “Interferer Data” in Figure 3-1 on page 3-5.

**Note**  
Custom patterns must be loaded into VSG Custom Signal Pattern memory before they are listed in the Custom Modulation Configuration window. See “VSG Custom Pattern Management” on page 3-6 for instructions pertaining to loading a pattern.

1. Press the Custom submenu key. The Custom Modulation Configuration dialog box opens. The following figure is an example only. Your instrument may show a different list.

![Custom Modulation Configuration](image)

**Figure 3-5.** Custom Modulation Configuration

2. The list is already active. Use the Up/Down arrow keys or the rotary knob to highlight a custom signal pattern and then press the Select submenu key or press Enter.

3. Select the Accept button or the Cancel button and then press Enter to either accept or abort and return to the previous menu (or press the Accept submenu key or the Cancel submenu key).

**Spectrum Inversion (Normal Reverse)**

For some cases of BER testing, the signal spectrum needs to be inverted. Spectrum inversion may also be needed if a mixer is used to convert the VSG output frequency.

Press the Spectrum Inversion submenu key to select Reverse and invert the signal spectrum.
3-8 Turning on the Signal Generator

After signal, interferer, and noise have been configured, press the RF On/Off main menu key to generate the configured signals.

![VSG Display and SPA Displays](image)

**Figure 3-6.** VSG Display and SPA Displays

In Figure 3-6, the upper screen (VSG Display) shows a VSG output signal in a typical VSG setup screen. The lower screen (SPA Display) shows how the same VSG output signal appears when viewed with a spectrum analyzer.
3-9  Vector Signal Generator Menus

Figure 3-7 shows the map of the Vector Signal Generator (VSG) menus. The following sections describe VSG main menus and associated submenus. The submenus are listed in the order they appear on the display from top to bottom under each main menu.

Figure 3-7.  Main Menu Keys
3-10 Freq (Frequency) Menu

Key Sequence: **Frequency**

**Signal Frequency**: Press to set the signal frequency.

**Communication Systems Standard**: Opens the Signal Standards dialog. Select the desired signal standard and press enter.

**Sig Channel Num**: Press to set the signal channel.

**Interferer Freq Offset**: Press to set the Interferer Freq Offset.

**Sig Freq Step**: Press to set the desired signal frequency step. This value is used when setting the Signal Frequency using the **Up/Down** arrow keys.

**Int Freq Step**: Press to set the desired interferer frequency step. This value is used when setting the Interferer Frequency Offset using the **Up/Down** arrow keys.

**Figure 3-8.** Freq Menu
3-11 Amplitude Menu

Use the rotary knob to increment/decrement the amplitude by 0.1 dB. Use the Left/Right arrow buttons to increment/decrement the amplitude by 1 dB. Use the Up/Down arrow buttons to increment/decrement the amplitude by 10 dB.

Key Sequence: Amplitude

<table>
<thead>
<tr>
<th>Amplitude</th>
<th>Signal Level</th>
<th>Interferer Level</th>
<th>Noise Level</th>
<th>Level Offset</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>## dBm</td>
<td>## dBm</td>
<td>## dBm</td>
<td>## dB</td>
</tr>
</tbody>
</table>

Signal Level: Press to set the signal level.
Interferer Level: Press to set the interferer level.
Noise Level: Press to set the noise level.
Level Offset: Press to set the level offset.

Signal: Sets the signal to CW, Mod, or Off. When Signal is set Off, the display indicator and data window text is colored gray. When Signal is set to CW or Mod, the display indicator and data window text is colored yellow. The CW indicator is shaped as an arrow, while the Mod indicator is shaped as a rectangle.

Interferer: Sets the interferer to CW, Mod, or Off. When interferer is set Off, the display indicator and data window text is colored gray. When interferer is set to CW or Mod, the display indicator and data window text is colored green. The CW indicator is shaped as an arrow, while the Mod indicator is shaped as a rectangle.

Noise: Turns the noise signal On or Off. When Noise is set Off, no indicator is displayed but data window text is colored gray. When noise is set On, a white line is drawn horizontally across the graphic display window and data window text is colored white.

Figure 3-9. Amplitude Menu
3-12  Setup Menu

Key Sequence:  Setup

![Diagram of Setup Menu]

**Trigger Type:**  Selects the use of the trigger and if the trigger is a positive edge or negative edge.

**Trigger Delay:**  Sets a trigger delay.

**Manual Trigger:**  Allows you to manually trigger, in case the external trigger is not working.

**Pattern Manager:**  Opens the Pattern File List window and lists the “Pattern Manager Menu” on page 3-16. This allows you to load custom signal files from internal memory or a USB memory device into the Custom Signal Pattern folder.

![Figure 3-10. Setup Menu]

### Pattern Manager Menu

Key Sequence:  Setup > Pattern Manager

![Diagram of Pattern Manager Menu]

**Add:**  Opens the list dialog and “Add Pattern Menu” on page 3-17 to add a pattern to the Pattern File List.

**Delete:**  Opens list dialog and the “Delete Pattern Menu” on page 3-17 to delete a pattern from the Pattern File List.

**Back:**  Returns to the “Setup Menu” on page 3-16.

![Figure 3-11. Pattern Manager Menu]
Add Pattern Menu
Key Sequence: Setup > Pattern Manager > Add

![Add Pattern Menu]

- **Add Selected Pattern**: Adds the selected pattern to the Pattern File List dialog box.
- **Cancel**: Returns to “Pattern Manager Menu” on page 3-16.

Figure 3-12. Add Pattern Menu

Delete Pattern Menu
Key Sequence: Setup > Pattern Manager > Delete

![Delete Pattern Menu]

- **Delete Selected Pattern**: Deletes the selected pattern from the Pattern File List dialog box.
- **Delete All Patterns**: Deletes all the patterns from the Pattern File List dialog box.
- **Cancel**: Returns to the “Pattern Manager Menu” on page 3-16.

Figure 3-13. Delete Pattern Menu
3-13  Modulation Menu

Key Sequence: Modulation

Signal Pattern: Opens the “Edit Signal Menu” on page 3-18 for Signal configuration.

Interferer Pattern: Opens the “Edit Interferer Menu” on page 3-19 for Interferer configuration.

Figure 3-14. Modulation Menu

Edit Signal Menu

Key Sequence: Modulation > Signal Pattern

Analog: Opens the “Analog Modulation Configuration” dialog box and Modulation Config menu to setup modulation type, frequency, and depth.

Digital: Opens the “Digital Modulation Configuration” dialog box and lists Modulation Config menu to select a modulation type and signal pattern.

Custom: Opens the “Custom Modulation Configuration” dialog box and the Modulation Config menu to select a pattern for use as signal or interferer.

Spectrum Inversion: Press to toggle Spectrum Inversion from Normal to Reverse. This may be necessary for some cases of BER testing.

Back: Returns to the “Modulation Menu” on page 3-18.

Figure 3-15. Edit Signal Menu
Edit Interferer Menu

Key Sequence: **Modulation > Interferer Pattern**

**Analog:** Opens the "Analog Modulation Configuration" dialog box and Modulation Config menu to setup modulation type, frequency, and depth.

**Digital:** Opens the "Digital Modulation Configuration" dialog box and lists Modulation Config menu to select a modulation type and signal pattern.

**Custom:** Opens the "Custom Modulation Configuration" dialog box and the Modulation Config menu to select a pattern for use as signal or interferer.

**Spectrum Inversion:** Press to toggle Spectrum Inversion from Normal to Reverse. This may be necessary for some cases of BER testing.

**Back:** Returns to the "Modulation Menu" on page 3-18.

![Edit Interferer Menu Diagram](image)

**Figure 3-16.** Edit Interferer Menu
When generating an AM sine wave, 7 discrete frequency settings are available, as shown in Table 3-1. After selecting a frequency, choose one of 7 settings for Percent Depth as shown in Table 3-2.

**Table 3-1. Sine Wave AM – Frequencies**

<table>
<thead>
<tr>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>400 Hz</td>
</tr>
<tr>
<td>1 kHz</td>
</tr>
<tr>
<td>3 kHz</td>
</tr>
<tr>
<td>5 kHz</td>
</tr>
<tr>
<td>10 kHz</td>
</tr>
<tr>
<td>15 kHz</td>
</tr>
<tr>
<td>20 kHz</td>
</tr>
</tbody>
</table>

**Table 3-2. Sine Wave AM – Percent Depth**

<table>
<thead>
<tr>
<th>Percent</th>
</tr>
</thead>
<tbody>
<tr>
<td>5%</td>
</tr>
<tr>
<td>10%</td>
</tr>
<tr>
<td>20%</td>
</tr>
<tr>
<td>30%</td>
</tr>
<tr>
<td>50%</td>
</tr>
<tr>
<td>70%</td>
</tr>
<tr>
<td>90%</td>
</tr>
</tbody>
</table>
Sine Wave FM

When generating an FM sine wave, 6 discrete rate settings are available, as shown in Table 3-3. After selecting a rate, choose one of 8 settings for Deviation in hertz, as shown in Table 3-4.

Table 3-3. Sine Wave FM – Rates

<table>
<thead>
<tr>
<th>Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 kHz</td>
</tr>
<tr>
<td>5 kHz</td>
</tr>
<tr>
<td>10 kHz</td>
</tr>
<tr>
<td>50 kHz</td>
</tr>
<tr>
<td>100 kHz</td>
</tr>
<tr>
<td>500 kHz</td>
</tr>
</tbody>
</table>

Table 3-4. Sine Wave FM – Deviations

<table>
<thead>
<tr>
<th>Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>100 Hz</td>
</tr>
<tr>
<td>500 Hz</td>
</tr>
<tr>
<td>1 kHz</td>
</tr>
<tr>
<td>5 kHz</td>
</tr>
<tr>
<td>10 kHz</td>
</tr>
<tr>
<td>50 kHz</td>
</tr>
<tr>
<td>100 kHz</td>
</tr>
<tr>
<td>500 kHz</td>
</tr>
</tbody>
</table>

Pulsed CW

Pulsed CW is available only as a single channel. Choose one of 3 settings for the period, as shown in Table 3-5.

Table 3-5. Period Settings for Pulsed CW

<table>
<thead>
<tr>
<th>Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1 msec (10 kHz)</td>
</tr>
<tr>
<td>1 msec (1 kHz)</td>
</tr>
<tr>
<td>2.5 msec (400 Hz)</td>
</tr>
</tbody>
</table>
Digital Modulation

The digital modulation types and their associated signal patterns are shown in Table 3-6.

Table 3-6. Digital Modulation Configuration

<table>
<thead>
<tr>
<th>Modulation Type</th>
<th>Signal Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>PSK</td>
<td>W-CDMA Pilot (QPSK, 3.84 Msym/s, RRC, alpha=0.22, PN9)</td>
</tr>
<tr>
<td></td>
<td>EDGE Continuous (3Pi/8-8PSK, 270.833 ksym/sec, Lin-Gauss, PN9)</td>
</tr>
<tr>
<td>QAM</td>
<td>DECT 16 QAM Continuous (1.152 Msym/s, RRC, alpha=0.5, PN9)</td>
</tr>
<tr>
<td></td>
<td>J.83C Digital Cable (16 QAM, 5 Msym/s, RRC, alpha=0.13, PN9)</td>
</tr>
<tr>
<td></td>
<td>DVB-C (16 QAM, 6.84 Msym/s, RRC, alpha=0.15, PN9)</td>
</tr>
<tr>
<td></td>
<td>DECT 64 QAM (1.152 Msym/s, RRC, alpha=0.5, PN9)</td>
</tr>
<tr>
<td></td>
<td>US Digital 64 QAM (5.056941 Msym/s, RRC, alpha=0.18, PN9)</td>
</tr>
</tbody>
</table>
3-14 RF On/Off

Key Sequence: RF On/Off

The RF On/Off main menu key turns on the enabled signals in the Amplitude menu.

This is what is displayed when the RF On/Off main menu key is pressed. The current state of the RF signal is displayed below the battery symbol.

Figure 3-19. RF On/Off Menu
Index

A
- add pattern menu (VSG) .................. 3-17
- Additive White Gaussian Noise (AWGN) 3-1
- amplitude menu (VSG) .................. 3-15
- amplitude parameters .................. 3-4
- analog modulation .................. 3-20
- analog modulation setup (VSG) ...... 3-8
- Anritsu, contact .................. 1-1
- averaging, trace operations, TG ...... 2-2

B
- band pass filter, TG measurement .... 2-1
- BER testing, spectrum inversion ...... 3-11

C
- calibration, tracking generator .... 2-1
- communication standards, selecting . 3-2
- contacting Anritsu .................. 1-1
- custom modulation pattern setup (VAG) 3-11
- custom pattern .................. 3-6
- Custom submenu key
  - Edit Interferer menu .................. 3-19
  - Edit Signal menu .................. 3-18
  - selecting a modulation pattern .... 3-8

D
- digital modulation config (VSG) .... 3-22
- digital modulation setup (VAG) ...... 3-10

E
- edit interferer menu (VSG) .......... 3-19
- edit signal menu (VSG) .............. 3-18
- erase pattern menu (VSG) .......... 3-17
- example measurement
  - tracking generator .................. 2-1
  - VSG setup .................. 3-1

F
- features
  - tracking generator .................. 2-1
  - vector signal generator .......... 3-1
- filter, band pass, TG measurement .. 2-1
- freq menu (VSG) .................. 3-14

G
- frequency
  - AM sine wave .................. 3-20
  - analog modulation, interferer .... 3-19
  - analog modulation, signal pattern 3-18
  - interferer offset (VSG) .......... 3-3
  - menu, VSG .................. 3-14
  - parameters, VSG .............. 3-2
  - range of tracking generator ...... 2-1
  - signal, entering .................. 3-2
  - tuning, tracking generator ...... 2-1

H
- generate signal (TG) .............. 2-1
- generate signal (VSG) .............. 3-12

I
- interferer (VSG)
  - frequency step .................. 3-3
  - level .................. 3-4
  - parameters .................. 3-3
  - pattern .................. 3-8

L
- links, contact .................. 1-1

M
- measure menu (TG) .............. 2-7, 2-8
- measurements
  - tracking generator
    - calibration .................. 2-1
    - example .................. 2-1
  - vector signal generator setup .... 3-1
- menu
  - add pattern (VSG) .......... 3-17
  - amplitude (VSG) .............. 3-15
  - edit interferer (VSG) ........ 3-19
  - edit signal (VSG) .......... 3-18
  - erase pattern (VSG) .......... 3-17
  - freq (VSG) .................. 3-14
  - measure, with tracking generator . 2-7, 2-8
- modulation (VSG) .............. 3-18
- parameters (VSG) .............. 3-6
- pattern manager (VSG) .......... 3-16
- S21 Insertion Loss (TG) .......... 2-10
- setup (VSG) .................. 3-16
- tracking generator .............. 2-9
menu map
  TG menus ....................... 2-6
  VSG menus .................... 3-13
mode, vector signal generator ...... 1-1
modulation (VSG)
  analog setup .................. 3-8
  digital setup .................. 3-10
  menu ......................... 3-18
  pattern ........................ 3-8
  pattern setup, custom .......... 3-11

N
noise level .......................... 3-4
normalization, TG .................. 2-3

O
offset, frequency interferer (VSG) .... 3-3
options, selecting a mode .......... 1-1

P
pattern manager menu (VSG) ........ 3-16
phase polarity ...................... 3-11

R
relative scale example, TG ........ 2-4
RF On/Off (VSG) .................... 3-12

S
S21 Insertion Loss menu (TG) ...... 2-10
setup menu (VSG) .................. 3-16
signal channel number, setting .. 3-3
signal frequency step, setting .. 3-3
signal frequency, entering .......... 3-2
signal level ........................ 3-4
signal parameters (VSG) ............ 3-2
signal pattern ...................... 3-8
spectrum inversion ................ 3-11
stop band of a filter, TG ........ 2-2

T
THROUGH connection, TG ........... 2-3
tracking generator
  calibration ...................... 2-1
  example measurement ............ 2-1
  menu ................................ 2-9
  menu map .......................... 2-6
  mode selection .................. 1-1
  startup .......................... 2-1
  trigger parameters ................ 3-6
  tuning frequency, tracking generator 2-1

V
vector signal generator mode selection 1-1
VSG menu map ....................... 3-13

W
web links, contact .................. 1-1
Anritsu utilizes recycled paper and environmentally conscious inks and toner.